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Download Article Learn how to insert a lined or art border in Microsoft Word documents on desktop Download Article Do you want to make an outside border in your Microsoft Word documents? You can easily add a solid or dotted border to an entire page or selected content. You can also use Microsoft Word's included designs to create an artistic
border for themed event flyers. This wikiHow will show you how to create a border around text, images, or pages in Microsoft Word using your Windows or Mac computer. To add a page border, click "Design" — "Page Borders". Select a border setting, style, and page application. Click "OK". To add a border around content, select the content. Click
the "Home" tab, then the arrow. Click "Borders and Shading..." and select as style. 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Windows.[1] You must have a subscription to use Office 365. Use this method to add a lined border around a Microsoft Word document. This is
different from changing the margins. 2 Click Design. This will be in the top toolbar, between Draw and Layout. Advertisement 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. 4 Click Page Border. This is the middle tab on the Borders and Shading
window. You may already be on this tab. 5 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's
art gallery. This border can be used for themed flyers for holidays and events. 6 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-
down menus, respectively. 7 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 8 Click
OK. It's at the bottom of the page. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Mac.[2] You must have a subscription to use Office 365. 2 Click Design. This will be in the top toolbar, between Draw
and Layout. 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. The Borders and Shading window will open, set to the Page Border tab. If it isn't already on the Page Border tab, click it now. 4 Select a border setting. In the left-most column, click the
border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 5 Select a border style.
In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 6 Select pages to use. If you created a new section earlier in this method, click
the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 7 Click OK. This is the blue button. This will apply the border to your document's specified page(s). Advertisement
1 Open a project in Microsoft Word. This looks like a W on top of a blue square. 2 Click Home. This is in the top toolbar, between File and Insert. 3 Select content. Click and drag your mouse across the text or image(s) around which you want to place a border. This method will place a border around an entire selection of images and text together. If
you want to place a border around a single image, double-click the image. Select a preset style from the Picture Styles section, or click Picture Border to set the color, weight, and design of the border.[3] 4 Click next to the "Borders" button. The Borders button resembles a square divided into four smaller squares; you'll find it in the "Paragraph"
section of options in the toolbar, just right of the paint bucket icon. A drop-down menu will open. On a Mac, click the Format menu item at the top of the screen instead. 5 Click Borders and Shading.... It's at the bottom of the drop-down menu. A new window will open. On a Mac, you'll find this option in the middle of the Format drop-down menu. 6
Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your text, select Box. 7 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select
from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. To add a border with images, click the Art drop-down menu and select a design. 8 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down
box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 9 Click OK. This will apply the border to your document's specified page(s). Advertisement Add New Question Question How can I place a
border around a picture I've inserted into a document? You do what is shown above, but instead, you click on the picture before you go through the steps. Question How do I put a border around a table in Microsoft Word? Go into Format --> Borders and Shading. There you'll find options for borders you can apply to the table. Question What three
options can I set regarding a picture border? The three option you can set are: small, medium and large. Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past,
Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,181,719 times. Co-
authors: 17 Updated: April 30, 2025 Views: 1,181,719 Categories: Microsoft Word Print Send fan mail to authors Thanks to all authors for creating a page that has been read 1,181,719 times. Download Article Learn how to insert a lined or art border in Microsoft Word documents on desktop Download Article Do you want to make an outside border in
your Microsoft Word documents? You can easily add a solid or dotted border to an entire page or selected content. You can also use Microsoft Word's included designs to create an artistic border for themed event flyers. This wikiHow will show you how to create a border around text, images, or pages in Microsoft Word using your Windows or Mac
computer. To add a page border, click "Design" — "Page Borders". Select a border setting, style, and page application. Click "OK". To add a border around content, select the content. Click the "Home" tab, then the arrow. Click "Borders and Shading..." and select as style. 1 Open a project in Microsoft Word. This looks like a W on top of a blue square.
Microsoft Word is available to install for Windows.[1] You must have a subscription to use Office 365. Use this method to add a lined border around a Microsoft Word document. This is different from changing the margins. 2 Click Design. This will be in the top toolbar, between Draw and Layout. Advertisement 3 Click Page Borders. You can find this
at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. 4 Click Page Border. This is the middle tab on the Borders and Shading window. You may already be on this tab. 5 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-
D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 6 Select a border style. In the "Style" column, scroll down until you find the border style you
want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 7 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you
want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 8 Click OK. It's at the bottom of the page. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on
top of a blue square. Microsoft Word is available to install for Mac.[2] You must have a subscription to use Office 365. 2 Click Design. This will be in the top toolbar, between Draw and Layout. 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. The Borders
and Shading window will open, set to the Page Border tab. If it isn't already on the Page Border tab, click it now. 4 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border
with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 5 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also
change the border's color and width from the Color and Width drop-down menus, respectively. 6 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section,
click This section - first page only in the drop-down menu. 7 Click OK. This is the blue button. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. 2 Click Home. This is in the top toolbar, between File and Insert. 3 Select content. Click and drag
your mouse across the text or image(s) around which you want to place a border. This method will place a border around an entire selection of images and text together. If you want to place a border around a single image, double-click the image. Select a preset style from the Picture Styles section, or click Picture Border to set the color, weight, and
design of the border.[3] 4 Click next to the "Borders" button. The Borders button resembles a square divided into four smaller squares; you'll find it in the "Paragraph" section of options in the toolbar, just right of the paint bucket icon. A drop-down menu will open. On a Mac, click the Format menu item at the top of the screen instead. 5 Click Borders
and Shading.... It's at the bottom of the drop-down menu. A new window will open. On a Mac, you'll find this option in the middle of the Format drop-down menu. 6 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the
way around your text, select Box. 7 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. To add a border with
images, click the Art drop-down menu and select a design. 8 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only
in the drop-down menu. 9 Click OK. This will apply the border to your document's specified page(s). Advertisement Add New Question Question How can I place a border around a picture I've inserted into a document? You do what is shown above, but instead, you click on the picture before you go through the steps. Question How do I put a border
around a table in Microsoft Word? Go into Format --> Borders and Shading. There you'll find options for borders you can apply to the table. Question What three options can I set regarding a picture border? The three option you can set are: small, medium and large. Ask a Question Advertisement Written by: wikiHow Technology Writer This article
was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media
outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,181,719 times. Co-authors: 17 Updated: April 30, 2025 Views: 1,181,719 Categories: Microsoft Word Print Send fan mail to authors Thanks to all authors for creating a page that has been read 1,181,719
times. Download Article Learn how to insert a lined or art border in Microsoft Word documents on desktop Download Article Do you want to make an outside border in your Microsoft Word documents? You can easily add a solid or dotted border to an entire page or selected content. You can also use Microsoft Word's included designs to create an
artistic border for themed event flyers. This wikiHow will show you how to create a border around text, images, or pages in Microsoft Word using your Windows or Mac computer. To add a page border, click "Design" — "Page Borders". Select a border setting, style, and page application. Click "OK". To add a border around content, select the content.
Click the "Home" tab, then the arrow. Click "Borders and Shading..." and select as style. 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Windows.[1] You must have a subscription to use Office 365. Use this method to add a lined border around a Microsoft Word document. This
is different from changing the margins. 2 Click Design. This will be in the top toolbar, between Draw and Layout. Advertisement 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. 4 Click Page Border. This is the middle tab on the Borders and Shading
window. You may already be on this tab. 5 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's
art gallery. This border can be used for themed flyers for holidays and events. 6 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-
down menus, respectively. 7 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 8 Click
OK. It's at the bottom of the page. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Mac.[2] You must have a subscription to use Office 365. 2 Click Design. This will be in the top toolbar, between Draw
and Layout. 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. The Borders and Shading window will open, set to the Page Border tab. If it isn't already on the Page Border tab, click it now. 4 Select a border setting. In the left-most column, click the
border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 5 Select a border style.
In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 6 Select pages to use. If you created a new section earlier in this method, click
the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 7 Click OK. This is the blue button. This will apply the border to your document's specified page(s). Advertisement
1 Open a project in Microsoft Word. This looks like a W on top of a blue square. 2 Click Home. This is in the top toolbar, between File and Insert. 3 Select content. Click and drag your mouse across the text or image(s) around which you want to place a border. This method will place a border around an entire selection of images and text together. If
you want to place a border around a single image, double-click the image. Select a preset style from the Picture Styles section, or click Picture Border to set the color, weight, and design of the border.[3] 4 Click next to the "Borders" button. The Borders button resembles a square divided into four smaller squares; you'll find it in the "Paragraph"
section of options in the toolbar, just right of the paint bucket icon. A drop-down menu will open. On a Mac, click the Format menu item at the top of the screen instead. 5 Click Borders and Shading.... It's at the bottom of the drop-down menu. A new window will open. On a Mac, you'll find this option in the middle of the Format drop-down menu. 6
Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your text, select Box. 7 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select
from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. To add a border with images, click the Art drop-down menu and select a design. 8 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down
box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 9 Click OK. This will apply the border to your document's specified page(s). Advertisement Add New Question Question How can I place a
border around a picture I've inserted into a document? You do what is shown above, but instead, you click on the picture before you go through the steps. Question How do I put a border around a table in Microsoft Word? Go into Format --> Borders and Shading. There you'll find options for borders you can apply to the table. Question What three
options can I set regarding a picture border? The three option you can set are: small, medium and large. Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past,
Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,181,719 times. Co-
authors: 17 Updated: April 30, 2025 Views: 1,181,719 Categories: Microsoft Word Print Send fan mail to authors Thanks to all authors for creating a page that has been read 1,181,719 times. Download Article Learn how to insert a lined or art border in Microsoft Word documents on desktop Download Article Do you want to make an outside border in
your Microsoft Word documents? You can easily add a solid or dotted border to an entire page or selected content. You can also use Microsoft Word's included designs to create an artistic border for themed event flyers. This wikiHow will show you how to create a border around text, images, or pages in Microsoft Word using your Windows or Mac
computer. To add a page border, click "Design" — "Page Borders". Select a border setting, style, and page application. Click "OK". To add a border around content, select the content. Click the "Home" tab, then the arrow. Click "Borders and Shading..." and select as style. 1 Open a project in Microsoft Word. This looks like a W on top of a blue square.
Microsoft Word is available to install for Windows.[1] You must have a subscription to use Office 365. Use this method to add a lined border around a Microsoft Word document. This is different from changing the margins. 2 Click Design. This will be in the top toolbar, between Draw and Layout. Advertisement 3 Click Page Borders. You can find this
at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. 4 Click Page Border. This is the middle tab on the Borders and Shading window. You may already be on this tab. 5 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-
D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 6 Select a border style. In the "Style" column, scroll down until you find the border style you
want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 7 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you
want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 8 Click OK. It's at the bottom of the page. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on
top of a blue square. Microsoft Word is available to install for Mac.[2] You must have a subscription to use Office 365. 2 Click Design. This will be in the top toolbar, between Draw and Layout. 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. The Borders
and Shading window will open, set to the Page Border tab. If it isn't already on the Page Border tab, click it now. 4 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border
with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 5 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also
change the border's color and width from the Color and Width drop-down menus, respectively. 6 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section,
click This section - first page only in the drop-down menu. 7 Click OK. This is the blue button. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. 2 Click Home. This is in the top toolbar, between File and Insert. 3 Select content. Click and drag
your mouse across the text or image(s) around which you want to place a border. This method will place a border around an entire selection of images and text together. If you want to place a border around a single image, double-click the image. Select a preset style from the Picture Styles section, or click Picture Border to set the color, weight, and
design of the border.[3] 4 Click next to the "Borders" button. The Borders button resembles a square divided into four smaller squares; you'll find it in the "Paragraph" section of options in the toolbar, just right of the paint bucket icon. A drop-down menu will open. On a Mac, click the Format menu item at the top of the screen instead. 5 Click Borders
and Shading.... It's at the bottom of the drop-down menu. A new window will open. On a Mac, you'll find this option in the middle of the Format drop-down menu. 6 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the
way around your text, select Box. 7 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. To add a border with
images, click the Art drop-down menu and select a design. 8 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only
in the drop-down menu. 9 Click OK. This will apply the border to your document's specified page(s). Advertisement Add New Question Question How can I place a border around a picture I've inserted into a document? You do what is shown above, but instead, you click on the picture before you go through the steps. Question How do I put a border
around a table in Microsoft Word? Go into Format --> Borders and Shading. There you'll find options for borders you can apply to the table. Question What three options can I set regarding a picture border? The three option you can set are: small, medium and large. Ask a Question Advertisement Written by: wikiHow Technology Writer This article
was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media
outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,181,719 times. Co-authors: 17 Updated: April 30, 2025 Views: 1,181,719 Categories: Microsoft Word Print Send fan mail to authors Thanks to all authors for creating a page that has been read 1,181,719
times. Adding a border in Word is a simple task that can enhance the look of your document. Whether you want to add a decorative touch or emphasize certain sections, you can do it in just a few clicks. By the end of this brief overview, you’ll know how to insert a border into your Word document with ease. Before we dive into the steps, let’s clarify
what we’re going to achieve. By following this tutorial, you’ll learn how to insert a border around a page in your Word document. This can be helpful for creating certificates, flyers, or just to make your document look more polished. To begin, go to the ‘Design’ tab on the ribbon and click on ‘Page Borders’. This will open the ‘Borders and Shading’
dialog box, where you can choose various options for your border, including style, color, and width. In the dialog box, select the ‘Page Border’ tab and choose your desired border style, color, and width. You can also select which pages you want the border to appear on, whether it’s the whole document, the first page only, or all pages except the first.
Once you’ve chosen your settings, click ‘OK’ to apply the border to your document. You should now see the border appear around the edges of your page. If it’s not quite right, you can always go back and adjust the settings until you’re happy with the result. After completing these steps, your Word document will have a neat, attractive border that
frames your content. You can experiment with different styles and colors to match the theme of your document or to stand out for a special occasion. Here are some additional tips to keep in mind when adding borders to your Word documents: Play around with different border styles and colors to find the perfect match for your document’s tone and
purpose. If you want a more subtle border, choose a light color and a thin width. For a formal document, such as a certificate, a classic single or double line border might be the best choice. You can add borders not only to the whole page but also to individual paragraphs, text boxes, and images. Remember that too much decoration can be distracting
- if in doubt, less is more! Yes, you can choose to add a border to just the top, bottom, left, or right side of the page by selecting the specific side in the ‘Borders and Shading’ dialog box. While Word does not directly support using custom images as page borders, you can insert an image and manually position it around the edges of your page as a
workaround. Yes, within the ‘Borders and Shading’ dialog box, you can specify which pages you want the border to appear on, whether it’s the whole document, the first page only, or all pages except the first. To remove a border, go back to the ‘Page Borders’ section in the ‘Design’ tab, and in the ‘Borders and Shading’ dialog box, click on ‘None’, and
then ‘OK’. Unfortunately, Word does not have a feature to save border settings as a template. However, you can copy and paste the border from one document to another or recreate it using the same settings. Open the ‘Borders and Shading’ dialog box. Choose your border settings. Apply the border to your document. Adding a border in Word is a
quick and easy way to give your document an extra pop of personality or professionalism. Whether you’re creating a certificate, a business report, or a party invitation, the right border can set the tone for your entire document. By following the simple steps outlined in this tutorial, you can effortlessly add a decorative or formal touch to your work.
Remember to play around with different styles and colors, but also keep in mind that sometimes less is more. With a little creativity and these handy tips, you'll be adding borders like a pro in no time. So go ahead, give it a try, and see how a simple border can transform your Word document into something special. Matthew Burleigh has been writing
tech tutorials since 2008. His writing has appeared on dozens of different websites and been read over 50 million times. After receiving his Bachelor’s and Master’s degrees in Computer Science he spent several years working in IT management for small businesses. However, he now works full time writing content online and creating websites. His
main writing topics include iPhones, Microsoft Office, Google Apps, Android, and Photoshop, but he has also written about many other tech topics as well. Read his full bio here. If you want to personalize your digital work, it is good that you learn how to add border in Word, and thus, you will fulfill the objective. Microsoft Word is a program that
provides thousands of opportunities for you to do admirable work. To take advantage of the software, you will have to explore the different tools it offers you and know how to use them at the right time.When you focus on learning how to add border in Word, you will be able to create a unique document that follows the standards specified by the
employer. You will give your document a unique style that identifies how you work. To create the borders in Word, you will have to do the following: 100% secure Part 1: How to Add a Page Border in Word (Good and Quick)In this section, we will show you a simple yet effective method to add page borders in Word. Whether you're using Windows or
Mac, this step-by-step guide will ensure you can create solid or dotted borders for your entire document or specific pages effortlessly. With clear examples and helpful screenshots, you'll be able to enhance the visual appeal of your documents in no timeHere is step by step:Step 1: Open Microsoft Word on your Windows or Mac computer.Step 2:
Access the "Page Layout" tab at the top.Layout tabStep 3: Click on "Page Borders" in the "Page Background" group.Page Background groupStep 4: Choose your preferred border style from the options provided.Step 5: Customize the border settings, such as color, width, and art elements.Customize the border settingsStep 6: Select whether the border
applies to the entire document or specific pages.Select whether the border appliesStep 7: Click "OK" to apply the page border to your Word document.Part 2: How to Customize Page Borders in WordDiscover the power of customization as we walk you through the process of personalizing page borders in Word. Building upon reference materials such
as videos and articles, we will provide you with a new example that's easy to follow. By listing detailed steps and incorporating relevant images, you'll have the creative freedom to design borders that suit your unique style and document requirements.Let's create a simple red dotted line border around a Word document using Microsoft Word 365:Step
1: Create a new document in Microsoft Word or open an existing one.Step 2: Click on the "Design" tab in the Word ribbon at the top of the window.Design tabStep 3: Look for the "Page Borders" option. It should be located in the "Page Background" group on the right side of the ribbon.Page Borders optionStep 4: To access the “Borders and Shading”
panel, click on “Page Borders”.Step 5: In the "Borders and Shading" window, make sure you are on the "Page Border" tab.Page Borders settingStep 6: Under the "Setting" section, choose "Dotted Line" from the drop-down menu.Step 7: Now, pick the color for your dotted line border. Click on the color swatch next to the "Color" option and select a
bright red color.Page Borders ColorStep 8: Adjust the width of the border by clicking the up or down arrow next to the "Width" option. For simplicity, let's choose "3 pt."Page Borders WidthStep 9: Check the "Preview" section to see a preview of your red dotted line border around the page.Step 10: Once you are happy with your border settings, click
the "OK" button to apply it to your document.And that's it! You now have a simple red dotted line border around your Word document. It should look something like this:Page Borders resultPart 3: How to Add a Text Border in WordIf you want to make your text stand out, this section will be your go-to guide. We'll show you how to add borders around
text in Word, catering to both Windows and Mac users. Our user-friendly examples and comprehensive steps, accompanied by helpful images, will ensure that your text borders perfectly complement your content and give your documents a professional touch.Step 1. Create a new document in Microsoft Word or open an existing one.Step 2. Type the
text that you want to add a border to.Step 3. Select the text by clicking and dragging your mouse over it.Step 4. Go to the "Home" tab in the Word ribbon at the top of the window.Home tabStep 5. Look for the "Borders" option in the "Paragraph" or "Font" group. It's represented by an icon with squares and lines.Step 6. Click on the small arrow next
to the "Borders" icon to open the borders menu.Borders iconStep 7. In the dropdown menu, choose "Outside Borders" to add a border around the selected text. You can also select other border styles like "All Borders" or "Inside Borders" from the menu.Borders sectionStep 8. To customize the border further, click on "Borders and Shading" at the
bottom of the menu.Step 9. In the "Borders and Shading" window, you can change line styles, colors, widths, and choose which sides of the text have the border.Borders tabStep 10. Click "OK" to apply the text border to your selected text.That's it! The process of adding a text border in Microsoft Word is the same for both Mac and Windows systems.
Whether you're using Word on a Mac computer or a Windows PC, you can easily follow these steps to enhance your text with borders and make your documents stand out.Part 4: How to Create a Border in Word Using TemplatesSimplify the border creation process with the use of templates. In this part, we'll demonstrate how you can utilize templates
to effortlessly design captivating borders for your Word documents. By listing step-by-step instructions and providing relevant images, you'll be able to craft visually appealing documents in just a few clicks.To create a border in Word using templates in WPS Office, follow these steps:Step 1: Open WPS Office on your computer or device.Step 2: Go to
the homepage and click on "Docs."Step 3: Select "Create from Template" to access the template library.the template libraryStep 4: Browse through the templates to find one with a border design that you like.the template borderStep 5: Click on the template you want to use, then click "Download" to start working with it.Download templateStep 6: The
selected template will open in WPS Writer. Customize the template by adding your text, images, or any other content you need.Step 7: Once you're satisfied with your changes, save the document.Save file WPSThat's it! You have now created a document in Word with a border using templates in WPS Office.Part 5: How to Remove a Page Border in
WordSometimes, you may need to make changes to your document layout, and that includes removing page borders. In this section, we'll guide you through the process of removing borders in Word. By following our easy-to-understand instructions and referring to helpful images, you'll be able to edit your documents with confidence and
precision.Step 1: Open your Microsoft Word document that contains the page border.Step 2: Go to the "Design" or "Page Layout" tab in the Word ribbon at the top of the window. The location of these tabs might vary depending on your Word version.Step 3: Look for the "Page Borders" option. It might be under the "Page Background" or "Page
Layout" tab.Page Borders iconStep 4: To access the “Borders and Shading” panel, click on “Page Borders”.Step 5: In the "Borders and Shading" window, make sure you are on the "Page Border" tab.Page Borders tableStep 6: Under the "Setting" section, select "None" from the drop-down menu. This will remove the page border.selectStep 7: Click the
"OK" button to apply the changes and remove the page border from your document.And that's it! The page border has now been successfully removed from your Word document. Your document should no longer have any visible border around the pages.Part 6: Why Use WPS Office?WPS Office logoLooking for a reliable and affordable office suite?
Enter WPS Office. A great alternative to Microsoft Office, WPS Office offers top-notch features without breaking the bank. With seamless compatibility, user-friendly interface, and cross-platform support, it's a smart choice for all your document needs. In this section, we'll explore why WPS Office is worth considering and how it can enhance your
productivity. Let's dive in and discover the benefits of using WPS Office.Price: WPS Office is more affordable than Microsoft Office, with a free version available that offers essential features.Compatibility: WPS Office is highly compatible with Microsoft Office formats, ensuring smooth collaboration with users of Microsoft Office.Features: WPS Office
provides a comprehensive set of tools, rivaling the capabilities of Microsoft Office.User-friendly Interface: WPS Office has an intuitive and easy-to-navigate interface.Cross-platform Support: It is available on various platforms, allowing you to work seamlessly across different devices.Cloud Integration: WPS Office integrates with popular cloud storage
services, making it easy to access and synchronize your documents.Regular Updates: The software receives regular updates to improve performance and add new features.Ultimately, the decision to use WPS Office or Microsoft Office depends on your specific needs and preferences. WPS Office is a compelling alternative with its affordability and
features.Free Office Download Use Word, Excel, and PPT for FREE, No Ads.Edit PDF files with the powerful PDF toolkit.Microsoft-like interface. Easy to learn. 100% Compatibility.Boost your productivity with WPS's abundant free Word, Excel, PPT, and CV templates. Algirdas Jasaitis FAQs About Creating a Border in Word:Do Borders Print in
Word?Yes, borders in Microsoft Word documents are intended to be printed when you print the document. The borders you add to your Word document using the "Page Borders" feature or by inserting shapes or lines are part of the document's content and layout, and they are meant to appear on the printed page.How Do I Add a Border to a Header
and Footer in Word?Step 1. Open your Word document.Step 2. Go to the "Insert" tab and click "Header" or "Footer" to open the respective section.Step 3. Switch to the "Design" tab in the Header & Footer Tools.Step 4. In the “Page Background” group, select “Page Border”.Step 5. Choose the border style you want (e.g., "Box" for a solid border).Step
6. Customize the border settings (color, width, etc.).Step 7. Specify whether it applies to "Header," "Footer," or "Both."Step 8. Click "OK" to apply the border to the header or footer.That's it! Now you have a border in your header and footer sections.How Do I Add a Custom Border to a Picture in Word?Here's a simple and short guide to adding a
custom border to a picture in Microsoft Word:Step 1. Open Microsoft Word and your document with the picture.Step 2. To choose a photo, click on it.Step 3. Go to the "Format" tab.Step 4. Click on "Picture Border" and choose "Picture Border Options."Step 5. You can change the border’s width, color, and style.Step 6. Optionally, add artistic effects to
the border.Step 7. Click outside the formatting pane to apply the custom border to the picture.That's it! Your picture now has a custom border in Microsoft Word.SummaryIn conclusion, this step-by-step guide has equipped you with the knowledge to add various types of borders in Word. We emphasized the advantages of using WPS Office for these
tasks due to its affordability, compatibility, features, and user-friendly interface. Beautify your documents and improve their visual appeal with borders, while also enjoying the benefits of WPS Office for your document processing needs. 100% secure Download Article Learn how to insert a lined or art border in Microsoft Word documents on desktop
Download Article Do you want to make an outside border in your Microsoft Word documents? You can easily add a solid or dotted border to an entire page or selected content. You can also use Microsoft Word's included designs to create an artistic border for themed event flyers. This wikiHow will show you how to create a border around text, images,
or pages in Microsoft Word using your Windows or Mac computer. To add a page border, click "Design" — "Page Borders". Select a border setting, style, and page application. Click "OK". To add a border around content, select the content. Click the "Home" tab, then the arrow. Click "Borders and Shading..." and select as style. 1 Open a project in
Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Windows.[1] You must have a subscription to use Office 365. Use this method to add a lined border around a Microsoft Word document. This is different from changing the margins. 2 Click Design. This will be in the top toolbar, between Draw and
Layout. Advertisement 3 Click Page Borders. You can find this at the left side of the Design section, next to Page Color. It will have an icon of a page with a yellow border. 4 Click Page Border. This is the middle tab on the Borders and Shading window. You may already be on this tab. 5 Select a border setting. In the left-most column, click the border
option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 6 Select a border style. In the
"Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 7 Select pages to use. If you created a new section earlier in this method, click the
"Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 8 Click OK. It's at the bottom of the page. This will apply the border to your document's specified page(s).
Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. Microsoft Word is available to install for Mac.[2] You must have a subscription to use Office 365. 2 Click Design. This will be in the top toolbar, between Draw and Layout. 3 Click Page Borders. You can find this at the left side of the Design section, next to
Page Color. It will have an icon of a page with a yellow border. The Borders and Shading window will open, set to the Page Border tab. If it isn't already on the Page Border tab, click it now. 4 Select a border setting. In the left-most column, click the border option that you want to use. Select from: None, Box, Shadow, 3-D, and Custom. If you want a
simple border to go all the way around your page, select Box. To add a border with fun images, click the Art drop-down menu and select from Word's art gallery. This border can be used for themed flyers for holidays and events. 5 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the
style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and width from the Color and Width drop-down menus, respectively. 6 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in
the resulting drop-down menu. To apply the border to the first page of your section, click This section - first page only in the drop-down menu. 7 Click OK. This is the blue button. This will apply the border to your document's specified page(s). Advertisement 1 Open a project in Microsoft Word. This looks like a W on top of a blue square. 2 Click Home.
This is in the top toolbar, between File and Insert. 3 Select content. Click and drag your mouse across the text or image(s) around which you want to place a border. This method will place a border around an entire selection of images and text together. If you want to place a border around a single image, double-click the image. Select a preset style
from the Picture Styles section, or click Picture Border to set the color, weight, and design of the border.[3] 4 Click next to the "Borders" button. The Borders button resembles a square divided into four smaller squares; you'll find it in the "Paragraph" section of options in the toolbar, just right of the paint bucket icon. A drop-down menu will open. On
a Mac, click the Format menu item at the top of the screen instead. 5 Click Borders and Shading.... It's at the bottom of the drop-down menu. A new window will open. On a Mac, you'll find this option in the middle of the Format drop-down menu. 6 Select a border setting. In the left-most column, click the border option that you want to use. Select
from: None, Box, Shadow, 3-D, and Custom. If you want a simple border to go all the way around your text, select Box. 7 Select a border style. In the "Style" column, scroll down until you find the border style you want to use, then click the style. Select from the various solid and dotted line styles. If needed, you can also change the border's color and
width from the Color and Width drop-down menus, respectively. To add a border with images, click the Art drop-down menu and select a design. 8 Select pages to use. If you created a new section earlier in this method, click the "Apply to" drop-down box, then click the section to which you want to apply the border in the resulting drop-down menu. To
apply the border to the first page of your section, click This section - first page only in the drop-down menu. 9 Click OK. This will apply the border to your document's specified page(s). Advertisement Add New Question Question How can I place a border around a picture I've inserted into a document? You do what is shown above, but instead, you
click on the picture before you go through the steps. Question How do I put a border around a table in Microsoft Word? Go into Format --> Borders and Shading. There you'll find options for borders you can apply to the table. Question What three options can I set regarding a picture border? The three option you can set are: small, medium and large.
Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and
has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,181,719 times. Co-authors: 17 Updated: April 30, 2025 Views: 1,181,719 Categories: Microsoft Word Print Send fan mail to
authors Thanks to all authors for creating a page that has been read 1,181,719 times.



